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Predgovor drugom izdanju

Mi zivimo nase svakodnevne zivote nesvesni sitnica i malih stvari koje
nam se desavaju ispred ociju. Prelazimo preko ociglednih stvari jer nam se
cine jednostavnim i logicnim. Ne osecamo potrebu da =zavirimo ispod
jednolicne jednostavne spoljasnosti stvari, ili samo to ne zelimo? Postavimo
sebi pitanje: Kada smo zadnji put pogledali neki objekat i zapitali se kako on
to radi? Kakvi se to procesi kriju iza njegovog nama dostupnog lica? Zasto se
nesto desava bas tako kako se desava? Kada smo neki objekat poslednji put
razlozili na sastavne delove snagom svojih misli? Kada smo zadnji put videli
iza ociglednog i dostupnog? Odgovori na ova pitanja leze u nama samima i
predstavljaju samu osnovu reversnog inzenjeringa. Sama teznja da se
pronikne u pocetke i uzroke stvari, da se do pocetnih uslova dodje od
rezultata otvara neverovatne mogucnosti, samo ako promenimo tacku
gledista, samo ako se sa mesta pasivhog posmatraca pomerimo u mesto
reversera, samo tako cemo doci do same srzi reversnog inzenjeringa. Imajte
na umu da se reversni inzenjering ne primenjuje samo na kompjuterima,
svuda oko nas je reversni inzenjering, samo to treba da uocimo.

Ovo je drugo izdanje knjige The Art Of Cracking koja je dobila novo
ime The Art Of Reversing jer je u nju sada utkana moja druga knjiga pod
nazivom PE and ASM for Crackers. U ovom drugom izdanju su dodata neka
poglavlja, neka su dopunjena ali veci deo ispravki se odnosio na gramaticko-
semanticke greske uocene u knjizi za ovo pisac duguje posebnu zahvalnost
MDHamel-u koji je uradio reviziju i lektorat knjige. Ovom prilikom bih zeleo
da se zahvalim svima koji su me podrzali i jos uvek me podrzavaju da
nastavim rad na ovom projektu.

Knjiga je posvecena svim ljudima koji su ostavili neizbrisiv trag u mom
zivotu: porodici, najboljim prijateljima, prvoj ljubavi, mentorima, ostalim
prijateljima, neprijateljima i ostalima koji nisu ovde nabrojani ali
predstavljaju manje ili vise bitan deo mog zivota.

"The more I learn, the more I realize how much I don "t know!”
ApOx
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INTRO TO CRACKING

Kao prvo poglavlje u knjizi ovo poglavlje ima za cilj da vas uvede u
reversni inzenjering i da vam pokaze samu oshovu crackovanja, nacin
razmisljanja i neke osnovne trikove sa alatima za cracking. Prvo cete usvojiti
neke osnovne pojmove vezane za cracking, naucicete kako se konfigurisu
alati koje cemo koristiti, i konacno cemo napraviti nas prvi crack.
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WHAT IS R.C.E.?

Reverse Code Engineering je tehnika pomocu koje dobijamo pocetne
vrednosti neke funkcije pocinjuci od njenih rezultata. Primeticete da sam
upotrebio uopstenu definiciju RCEa, a ne onu koja bi se odnosila na RCE
primenjen na kompjuterske aplikacije. RCE sam definisao ovako jer je on
upravo to, bez obzira na oblast na koju se primenjuje RCE predstavlja
tehniku razmisljanja, odnosno postupak resavanja nekog problema iz drugog
ugla. Ali ako se ogranicimo samo na kompjutere onda cemo RCE definisati
kao tehniku modifikacije nepoznatog koda, kada izvorni kod samog programa
nije dostupan. Koristeci tehnike opisane u ovoj knjizi shvaticete osnovne
probleme pri modifikaciji ili analizi nepoznatog koda kada nije poznat izvorni
kod samog problema. Tada moramo pristupiti reversnom posmatranju
problema, to jest trazenju uzroka razlicitih ponasanja programa, pocevsi od
samih posledica, da bi smo stigli do pocetnik uzroka. Naravno kao i svaka
druga oblast ljudskog delovanja, pa tako i u RCEu imamo razlicite probleme
koji u vecini slucaja nemaju jedinstvena resenja. Ovo ujedno znaci da se
vecina problema moze resiti na veliki broj nacina i da u vecini slucajeva
postoje samo najlaksa, odnosno najbrza resenja, i ona koja to nisu. Posto
nas u vecini slucajeva ne zanima vreme potrebno da se neki problem resi,
glavni faktor u resavanju RCE problema ce biti tacnost dobijenih rezultata.
Ova tacnost je surova kada se radi o RCE problemima, jer u vecini slucajeva
postoje samo dva slucaja resavanja problema. Postoje samo tacno reseni
problemi i oni koji to nisu. RCE problemi koji su netacno reseni mogu dovesti
do nestabilnosti sistema, kao i do pucanja samog operativhog sistema koji
koristimo kao osnovu za RCE. Ovo ujedno znaci da RCE nije platformski
definisan jer se moze primenjivati, a i primenjuje se, na svim kompjuterskim
platformama.

Iako je ova knjiga “pompezno” nazvana The Art Of Cracking ona se ne
odnosi na pravo znacenje reversnog inzenjeringa, niti je tako nesto uopste
moguce. Ne, ova knjiga je sebi stavila za cilj da se ogranici samo na jednu
usko definisanu oblast, popularno nazvanu Cracking, tezeci da opise sto je
vise moguce pojava vezanih za sam Cracking. Naravno i ovo je tesko
izvodljivo ali cu se potruditi da vas kroz ovu knjigu uverim da nepostoji stvar
koja se naziva “sigurna aplikacija”. Od sada pa na dalje ovaj termin izbrisite
iz svoga recnika. Termin koji cete usvojiti umesto toga je: “aplikacija teska
za reversing!”, sto znaci da svaka aplikacija koja moze da se pokrene moze
biti “slomljena” i da ne treba verovati takozvanim komercijalnim aplikacijama
za zastitu vasih ili tudjih programa. Ova knjiga ce unistiti zablude onih koji
veruju da su njihovi passwordi bezbedni u bazama podataka, da su njihovi
passwordi bezbedni iza “zvezdica”. Ovakve zablude ce pasti u vodu posle
citanja ove knjige. Programeri spremite se, jer vase aplikacije ce biti
stavljene na obiman test...

The Art of Reversing by ApOx Page 7 of 293



BEGINNERS GUIDE TO REVERSING

Pre nego sto pocnete da se bavite reversnim inzenjeringom potrebno
je da znate neke osnove kompjuterske hijerarhije i nacine zapisivanja/citanja
podataka. Operativni sistem koji smo izabrali da na njemu savladamo osnove
reversnog inzenjeringa je Windows, koji ce nam, bez obzira na verziju, pruziti
uvid u arhitekturu i nacin razmisljanja koji se sprovodi prilikom reversinga.

Iako sam siguran da vec znate da je sama osnova Windows
operativnog sistema niz executabilnih (.exe) i statickih (.d/l) fajlova, koji
predstavljaju jezgro sistema. Ono sto vecina od vas sigurno nije znala je da
se sadrzaj tih .exe i .dll fajlova moze menjati na nacin na koji ce ti programi
izvrsavati instrukcije koje mi zelimo. Tehnika modifikovanja tudjih
executabilnih i drugih fajlova koji sadrze izvrsni kod naziva se Cracking.
Imajte na umu da je reversing aplikacija za koji nemate odobrenje od njenih
autora krajnje nelegalan i stoga budite obazrivi u odabiru meta koje cete
reversovati.

Sada se sigurno pitate kako nam saznanje da se operativni sistem
sastoji od velikog broja .exe i .dll fajlova moze pomoci u reversingu? Pa
posto znamo ovo mozemo da pretpostavimo da se njihov sadrzaj na neki
nacin zapisuje u sam .exe fajl! Ovde smo vec na pravom tragu jer svi .exe i
(dll fajlovi imaju jedinstvene nacine zapisivanja. Ovi nacini zapisivanja su
standardizovani na Windows 32bitnim sistemima (verzije Windowsa od 98 pa na
dalje) i naziva se PE (Portable Executable) standard. Ovaj standard usko
definise pozicije i znacenja svakog bajta (najmanje jedinice svakog fajla,
1024b=1kb) u jednom standardnom .exe fajlu. Sa ovim standardom cemo se
kasnije upoznati ali je za sada bitno da znate da je deo standardnog PE fajla
zaduzen za izrsavanje samih funkcija koje taj .exe fajl obavlja. Ove funkcije
su napisane na takodje standardan masinski nacin. Ovo samo znaci da nizovi
bajtova koji predstavljaju izvrsni kod imaju tacno svoje znacenje. Tumacenje
niza bajtova obavlja sam procesor vaseg racunara, a ove standardne
komande se nazivaju ASM (asembler) komande. Sa ASM standardom cemo se
upoznati na samom pocetku ove knjige. Razumevanje tog dela knjige je
preduslov za razumevanje svih ostalih poglavlja i stoga ono predstavlja
okosnicu za celo razumevanje ove knjige.

Ovo su samo osnovni nacini razmisljanja koje bi svi pocetnici morali da
imaju u vidu pre nego sto pocnu da se bave reversingom. Ostale jako bitne
stvari ce biti uvodjene paralelno sa problemima sa kojima cete se sretati
prilikom citanja ove knjige.
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BECOMING A REVERSER

Ovo je jako cesto pitanje koje svi koji hoce da se bave reversingom
postavljaju sebi. Kako postati reverser? Sta to uopste znaci? Sta sve moram
da znam?

Odgovori na ova pitanja su vise individualni, zavise od osobe do osobe,
ali ono sto sam ja naucio tokom ovih godina baveci se programiranjem i
reversingom je da je sve moguce, da se sve moze uraditi. Jedine dve stvari
koje su potrebne za resavanje svakog problema su vreme i strpljenje. U zelji
da postanete ono sto zelite da postanete moracete da naucite mnogo toga.
Vecina stvari koje cete nauciti ce imati veze sa strukturom racunara, nacinom
izvrsavanja programa, strukturom samih fajlova, strukturom Windowsa, ali
pored svega ovoga moracete da naucite osnove kriptografije i matematike.
Verovali ili ne ali najbolji problemi reverserskog sveta su matematicki. Stoga
ma koliko mrzeli matematiku, verujte mi na rec, zavolecete je sigurno...

Kao sto sam vec rekao ne postoji tacan “recept” kako postati reverser
ali postoje osnovni vodici koji ce vas voditi linijom kojom morate uciti kako
biste postali reverser. Ovaj redosled bi trebalo da izgleda ovako:

e

%

Osnove Windows operativnog sistema

Osnove hexadecimalno/decimalnih brojeva

Osnovni set ASM komandi

Osnovni crackerski alati: W32Dasm i Hiew

Osnovni crackerski alati: Soft ICE, Olly, SmartCheck, DeDe
Osnove PE struture

Osnovni crackerski alati: PelD, ResHacker, LordPe, ImpRec
Programski jezici: Visual Basic, Delphi, C++, MASM
Osnove kriptografije: SHA1, MD5, RSA, RC4,RC5,SkipJask

X3

%

X3

%

X3

%

X3

%

X3

%

5

%

5

%

5

%

Naravno ovaj redosled se odnosi na neki logicki redosled razmisljanja i
ucenja koje bi trebalo primeniti da biste stekli konacan uvid u reverserske
probleme. Naravno analogno ovome postoji i spisak vrsta meta koje bi
trebalo da “razbijate”. Ovaj spisak bi trebalo da izgleda ovako:

5

%

Uklanjanje NAG ekrana

Menjanje skokova u cilju dolaska do poruka o tacnoj registraciji
Napredno patchovanje, ubijanje dialoga, CD zastite...

Pecanje serijskih brojeva uz pomoc debuggera

Jednostavno otpakivanje lakih meta: ASPack, UPX

Izmena samih meta u svoje keygeneratore

Pravijenje keygeneratora u nekom programskom jeziku

ASM ripovanje keygeneratora

Pravijenje bruteforcera

Odpakivanje naprednih protektora: ASProtect, ACProtect, SKVP, Armadillo
Napredni reversing meta u cilju razumevanja tudjeg algoritma

5

%

5

%

e

A

e

A

e

A

X3

%

X3

%

X3

%

X3

%

X3

%

Da li cete postati reverseri posle citanja ove knjige?
Ne, ali cete biti na dobrom putu da to postanete....
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ASM BASICS

ASM je osnova svakog reverserskog problema, zbog cega je potrebno
dobro znati makar osnovne ASM komande kako biste mogli da razumete kod
koji se nalazi ispred vas. Osnovni i jedini alat koji ce nam trebati dalje u
poglavlju je OllyDBG, ali cemo se za pocetak baviti teorijom.

ASM FOR CRACKERS - PART |

ASM koji cu ja ovde objasniti nije ASM koji koriste programeri da bi
pisali programe. Ne iako je vecina komandi ista ovde ce biti samo reci o
sustini svake ASM komande sa kojom cete se sresti tokom reversovanja
meta. Pocecemo sa malo matematike...

Posto se kao osnova svakog programa navode jednostavne
matematicke operacije, stoga su osnovne ASM komande namenjene bas
ovim operacijama.

Dodeljivanje vrednosti - je osnovna ASM komanda koja se koristi kako
bi se nekim promenljivim (EAX,EBX,EDX,ECX,...) cija su imena definisana
konstanta dodelila neka aritmeticka vrednost. Ovo bi u asembleru izgledalo
ovako:

MOV EAX,1
a njeno matematicko znacenje je: EAX = 1.

Sabiranje - je osnovna matematicka operacija i svima je veoma dobro
poznata. Siguran sam da znate da sabirate ali verovatno ne znate kako se
vrsi sabiranje brojeva u asembleru. Primer sabiranja dve promenljive je:

ADD EAX,EBX

Ova jednostavna ASM komanda je ekvivalent matematickoj komandi
sabiranja dva broja: EAX = EAX + EBX.

Oduzimanje - je takodje osnovna matematicka komanda koja bi u
asembleru izgledala ovako:

SUB EAX,EBX

Ova jednostavna ASM komanda je ekvivalent matematickoj komandi
oduzimanja dva broja: EAX = EAX - EBX.

Mnozenje - je cesto koristena komanda, a izgleda bas ovako:

IMUL EAX,EBX
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Ova jednostavha ASM komanda je ekvivalent matematickoj komandi
mnozenja dva broja: EAX = EAX * EBX.

Ovo su za pocetak samo neke osnovne ASM komande koje cemo iskoristiti da
resimo neke jednostavne matematicke probleme. Za sada nema potrebe da
brinete o tome koje cemo promenljive koristiti, za sada to necu objasnjavati
jer nema potrebe, kasnije cu doci do toga, za sada je samo vazno da shvatite
kako se izvrsavaju ASM komande.

Prvo cemo napisati program koji ce pomnoziti dva broja i na njihov proizvod
dodati 4.

Resenje:

MOV EAX,3
MOV ECX,4
IMUL EAX,ECX
ADD EAX,4

Mislim da je jasno kako radi ovaj jednostavan program ali za svaki slucaj
objasnicu zasto smo program napisali bas ovako. Prvo moramo dodeliti
vrednost promenljivim EAX i ECX kako bismo imali sta da mnozimo. Ovo se
radi u prva dva reda. Posle ovoga radimo standardno mnozenje dva broja,
posle cega cemo u poslednjem redu na njihov proizvod dodati 4. Naravno
rezultat izvrsenja ovog programa bice: 3 * 4 + 4 = 16.

Probacemo da uradimo modifikaciju ovog primera tako da program posle
dodavanja 4 na proizvod oduzme 8 i rezultat pomnozi sa 4.

Resenje:

MOV EAX,3
MOV ECX,4
IMUL EAX,ECX
ADD EAX,4
SUB EAX,8
IMUL EAX,4

Kao sto vidimo rezultat ce biti: (((3 * 4) + 4) - 8) * 4 = 32. Naravno treba
imati na umu da ako pisemo ASM programe svi brojevi moraju biti u
heksadecimalnom obliku, stoga ce rezultat poslednjeg zadatka biti 20h a ne
32.

Posto smo uspesno savladali rad osnovnih matematickih operacija vreme je
da objasnimo zasto i kako koristimo promenljive.

Kao i u matematici i u asembleru mozemo definisati promenljive kojima
mozemo dodeljivati bilo koju aritmeticku vrednost. Jedino ogranicenje kada
se radi sa asemblerom je da postoji vec definisani broj promenljivih koje
mozemo koristiti. Ove promenljive se nazivaju registri i koriste se za sve
asemblerske operacije. Neka imena ovih registara su vec pomenuta ali ceo
spisak bi izgledao ovako: EAX,EBX,ECX,EDX,ESP,EBP,ESI,EDI,EIP. Ovi
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registri iako se mogu koristiti za bilo koje operacije, bivaju dodeljeni
specificnim tipovima operacija. Pa tako:

EAX sluzi za osnovne matematicke operacije,

EBX sluzi za osnovne matematicke operacije,

ECX sluzi kao brojac u petljama,

EDX sluzi kao registar u koji se snima ostatak deljenja i za druge stvari,
ESP sluzi kao pointer do raznih kontrola/stacka,

EBP sluzi kao pointer do delova memorije,

ESI sluzi kao slobodan registar,

EDI sluzi kao slobodan registar,

EIP  sluzi kao pointer ka trenutnoj RVA adresi.

Ali ovo ne znaci da treba da shvatite ovaj spisak upotrebe registara crno-
belo, ovo su samo najcesce upotrebe registara, ali se njihovo koriscenje
moze menjati u zavisnosti od situacije do situacije. Videli smo da kao i
promenljive u matematici, registri mogu uzimati bilo koju brojnu vrednost i
koristiti se za matematicke operacije. Pre nego sto nastavimo sa
objasnjavanjem ostalih ASM komandi potrebno je da shvatite razliku izmedju
32bit, 16bit i 8bit registara i da uvidite vezu izmedju njih.

Registri koje smo gore upoznali (EAX-EIP) su 32bitni registri. Ovo znaci da
brojevi koje mogu sadrzati registri krecu se od 00000000 - FFFFFFFF, sto cini
ove registre 32bitnim. Zbog kompatibilnosti sa starijim standardima 32bitni
registri u sebi sadrze 16bitne i 8bitne registre. Ovo znaci da ako na primer
EAX sadrzi heksadecimani broj FF443322 on predstavlja njegovu 32bitnu
vrednost. Ali postoje drugi registri koji su u tesnoj vezi sa samim registom
EAX. Ovi registri su AX (16bit), AH (8bit) i AL(8bit). Veza izmedju registara je
data u sledecoj tablici:

Registar Prvi bajt Drugi bajt Treci bajt Cetvrti bajt
EAX FF 44 33 22
AX -- -- 33 22
AL -- -- -- 22
AH -- -- 33 --

Kao sto se vidi u tablici postoje registri pomocu kojih se moze modifikovati ili
samo pristupati razlicitim delovima 32bitnih registara. Iako je primer dat na
registru EAX isto vazi i za ostale registre. Ovo je jako bitno jer je potrebno
razumeti zasto se 32bitni registri u programima menjaju ako se promeni neki
od 8bitnih ili 16bitnih registara. Primera radi objasnicu pristupanje delovima
EAX registra na primeru:

MOV EAX,FF443322
MOV AX,1111

MOV AH,22

MOV AL,66

Rezultat izvrsavanja ovih ASM komandi po redovima bi bio:
EAX = FF443322, EAX = FF441111, EAX = FF442211, EAX = FF442266. Kao
sto primecujete nemoguce je pristupiti prvom i drugom bajtu 32bitnog
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registra EAX preko 16bitnih ili 8bitnih registara. Ovo je bitno kod pisanja
keygeneratora iz razloga sto je bitno znati kako ce 16/8bitni registi promeniti
konacnu vrednost nekog registra. Sada vam je sigurno jasno sta smo radili
kada smo pisali jednostavne ASM programe gore. Posto za sada znamo samo
cetiri ASM komande vreme je da prosirimo ovaj spisak sa dodatnim
matematickim ASM komandama.

Dodavanje +1 - je dodatna matematicka operacija koja radi dodavanje
vrednosti 1 na bilo koji registar. U ASM-u to izgleda ovako:

INC EAX

Ova jednostavna ASM komanda je ekvivalent matematickoj EAX = EAX + 1.
Sada se sigurno pitate zasto ovo jednostavno ne bismo uradili pomocu ASM
komande ADD. Odgovor je da ASM komanda ADD zauzima od 4-8 bajtova u
fajlu dok INC zauzima samo jedan. Nije velika usteda ali kompajleri tako
sastavljaju exe fajlove.

Oduzimanje -1 - je dodatna matematicka operacija koja radi
oduzimanje vrednosti 1 od bilo kojeg registra. Ona u ASM izgleda ovako:

DEC EAX

Ova jednostavna ASM komanda je ekvivalent matematickoj EAX = EAX - 1.
Ova komanda takodje zauzima samo jedan bajt u fajlu.

Deljenje - je matematicka operacija koju sam ostavio za kraj iz razloga
sto je potrebno poznavanje registara kako biste razumeli kako se brojevi dele
u ASMu. Primer deljenja dva broja:

MOV EAX,10
MOV ECX,4
MOV EDX,0
DIV ECX

Iako ovo izgleda malo komplikovano u stvari i nije. Ovde se desava sledece:
Prvo EAXu i ECXu dodeljujemo vrednosti, onda EDXu dodeljujemo vrednost
nula jer ce EDX sadrzati ostatak pri deljenju, i na kraju delimo sa ECX. Ovo bi
matematicki izgledalo ovako:

EAX = 16 (decimalno)

ECX =4

EDX =0

EAX = EAX / ECX
Da li je potrebno postavljati EDX na nula? Jeste jer ako ovo ne uradite
izazvacete integer overflow i program ce se srusiti. Deljenje mozda izgleda
malo komplikovano ali nije kada naucite da se uvek EAX deli sa nekim
drugim registrom koji vi izaberete a u ovom slucaju ECXom.
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Posto smo naucili sve osnovhe matematicke komande provezbacemo ih na
jednom primeru. Na primer napisacemo jedan ASM program koji ce sabrati
dva broja, pomnoziti njihov zbir sa 4, dodati vrednost jedan na proizvod, od
proizvoda oduzeti 6, podeliti oduzetu vrednost sa 3 i na kraju oduzeti jedan
od rezultata.

Resenje:
MOV EAX,4
MOV ECX,3
ADD EAX,ECX
IMUL EAX,4
INC EAX
SUB EAX,6
MOV EDX,0
MOV ECX,3
DIV ECX
DEC EAX

Mislim da je svima jasno sta se ovde desava, ali ako nije evo matematickog
resenja problema:

EAX = 4

ECX =3

EAX = EAX + ECX

EAX = EAX * 4

EAX = EAX + 1

EAX = EAX - 6
EDX =0

ECX =3

EAX = EAX / ECX
EAX = EAX -1

Razumevanje osnovnih matematickih operacija je kljucno kod resavanja
osnovnih reverserskih problema. Posto smo uradili sve osnovne matematicke
komande vreme je da uradimo logicke ASM komande. Ne plasite se ovim
nazivom, jer logicke komande predstavljaju samo matematicke operacije sa
logickim operatorima kao sto su NOT,AND,OR i slicni. Ovo je isto kao kada se
u matematici koriste konjukcije, disjunkcije i slicni operatori. Rezultati ovih
matematickih operacija su ili TRUE ili FALSE.

AND - je osnovna logicka komanda u ASMu. Koristi se kao logicki
operator izmedju dva registra. Ona u ASM izgleda ovako:

AND EAX,ECX

Posle izvrsavanja ove komande EAX dobija vrednost koja korespondira
matematickoj operaciji izmedju dva registra. Da biste detaljno razumeli sta
radi ova logicka komanda napravicemo malu tabelu sa dva binarna broja i
prikazacemo kako bi se racunao rezultat koji cemo dobiti primenom komande
AND. Recimo da logicki pokusavamo da saberemo 3 i 5.
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Operacija AND

Broj decimalno

Broj binarno

EAX 3 0011
ECX 5 0101
Rezultat - EAX 1 0001

Kao sto se vidi iz gornje tabele rezultat logickog sabiranja 3 AND 5 = 1.
Zasto je to bas broj 1? AND komanda uporedjuje binarne brojeve bit po bit i
na osnovu toga formira rezultat. Ako su bitovi 0 i 0, 0i 1ili 1 i 0 rezultat ce
uvek biti 0, a jedino ako su dva bita koja se porede jednaka 1 onda ce
rezultat za taj bit biti jednak 1. Zbog ovoga je 0011 AND 0101 = 1.

OR - je logicka komanda u ASMu. Koristi se kao logicki operator
izmedju dva registra. Ona u ASM izgleda ovako:

OR EAX,ECX

Posle izvrsavanja ove ASM komande rezultat ce se postaviti u EAX, a
vrednost koju ce dobiti registar EAX je prikazana u sledecoj tabeli:

Operacija OR

Broj decimailno

Broj binarno

EAX 3 0011
ECX 5 0101
Rezultat - EAX 7 0111

Kao sto se vidi iz gornje tabele rezultat logicke komande OR nad brojevima 3
i 5je 7. Ali zasto je rezultat bas 7? OR komanda uporedjuje binarne brojeve
bit po bit, na osnovu cega formira rezultat. Ako su nasi brojevi 0011 i 0101
rezultat ce biti 0111 jer OR komanda u rezultat stavlja 0 samo ako su oba
bita jednaka 0 a ako je prvi ili drugi bit jednak 1 onda ce i rezultat biti 1.

NOT - je logicka komanda u ASMu. Koristi se kao logicki operator koji
se primenjuje na jedan registar. Primer:

NOT EAX

Posle izvrsavanja ove ASM komande EAX dobija vrednost koja se moze
procitati iz sledece tablice:

Operacija NOT

Broj decimalno

Broj binarno

EAX

3

0011

Rezultat - EAX

12

1100

Kao sto se vidi u tabeli NOT komanda samo invertuje bitove. To jest ako je
bit jednak 0 onda ce u rezultatu biti jednak 1 i obrnuto. Ovo je krajnje
jednostavna ASM komanda.
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XOR - je jako bitna ASM komanda koja se zbog svoje reverzibilnosti
koristi u svrhe enkripcije i dekriptcije. Ova komanda se primenjuje na dva
registra a u ASM izgleda ovako:

XOR EAX,ECX

Posle izvrsavanja ove ASM komande EAX dobija vrednost koja se dobija
XORom EAXa ECXom. Princip XORovanja se vidi iz sledece tablice:

Operacija XOR Broj decimalno Broj binarno
EAX 3 0011
ECX 5 0101
Rezultat - EAX 6 0110

Rezultat je 6, ali zasto? XOR je takva operacija koja uporedjuje bitove iz
EAXa i ECXa tako da ako je bit iz sourcea (EAXa) razlicit od mete (ECXa)
onda se u rezultat smesta 1 a ako su brojevi isti onda se u rezultat smesta 0.
Zbog ovoga je 0011 XOR 0101 = 0110 to jest 3 xor 5 = 6. XOR funkcija je
najbitnija zbog svoje reverzibilnosti. Ovo znaci da je 3 xor 5 = 6 ali i da je 6
xor 5 = 3 i da je 6 xor 3 = 5. Takodje bitha osobina XOR funkcija je da ako
XORujemo jedan broj samim sobom uvek cemo dobiti nulu kao rezultat, to
jest 3 xor 3 = 0.

Ovo su bile najbitnije logicke ASM funkcije. Da bismo utvrdili ono sto smo do
sada naucili uradicemo jedan zadatak. Napisacemo ASM kod koji ce sabrati
dva broja, zatim ce XORovati rezultat sa 7, na sta cemo logicki dodati 4,
uradicemo negaciju, pa cemo uraditi logicko oduzimanje broja 5 od dobijene
vrednosti, i na kraju cemo uraditi negaciju dobijene vrednosti.

Resenje:
MOV EAX,2
MOV ECX,3
ADD EAX,ECX
XOR EAX,7
AND EAX,4
NOT EAX

OR EAX,5
NOT EAX

Resenje ove jednacine bice NOT ((NOT ((2 + 3) xor 7) AND 4) OR 5) = 0.
Naravno primetili ste da je u pitanju dupla negacija koja se ovde potire pa
nema ni potrebe za njenim uvodjenjem u algoritam.

LEA - je matematicka komanda u ASMu. Koristi se kao matematicki
operator za izvrsavanje vise operacija istovremeno. Ona u ASM izgleda
ovako:

LEA EAX,DWORD PTR DS:[ECX*4+6]
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Posle izvrsavanja ove ASM komande rezultat ce se postaviti u EAX, a
vrednost koju ce dobiti registar EAX je jednaka rezultatu ECX*4+4+6. Naravno
ovde se postuje princip matematicke prednosti operacija tako da ce se prvo
izvrsiti mnozenje a tek onda sabiranje.

SHL/SHR - je binarna komanda koja se koristi za pomeranje bajtova u
registrima u levu ili desnu stranu. Ova komanda bi u ASM izgledala ovako:

SHR AL, 3

Dakle vidimo da da SHR/SHL komanda ima dva parametra: destination u
vidu registra nad kojim se primenjuje operacija i count koji nham govori za
koliko se brojevno pomera binarna vrednost AL registra. U praksi izvrsenje
gornje komande, ako bi AL binarno bio jednak 01011011, bi izgledalo ovako:

01011011 - Originalni AL sadrzaj

00101101 - Pomeranje ALa u desno za jedno mesto
00010110 - Pomeranje ALa u desno za jos jedno mesto
00001011 - Pomeranje ALa u desno za jos jedno mesto

Svi bajtovi koji su pomeranjem dovedeni do kraja fizicke velicine registra
bivaju istisnuti. Poslednji istisnuti bajt se snima kao carry-flag. Naravno ova
operacija se moze primenjivati i na 8bitnim, 16bitnim i na 32bitnim
registrima.

ROL/ROR - je binarna komanda koja se koristi za rotaciju bajtova u
registrima u levu ili desnu stranu. Ova komanda bi u ASM izgledala ovako:

ROL AL,3

Dakle vidimo da da ROL/ROR komanda ima dva parametra: destination u
vidu registra nad kojim se primenjuje operacija i count koji nam govori za
koliko se brojevno pomera binarna vrednost AL registra. U praksi izvrsenje
gornje komande, ako bi AL binarno bio jednak 01011011, bi izgledalo ovako:

01011011xxx — Originalni AL sadrzaj

x01011011xx — Pomeranje ALa u desno za jedno mesto
xx01011011x - Pomeranje ALa u desno za jos jedno mesto
xxx01011011 - Pomeranje ALa u desno za jos jedno mesto
11001011 - Konacan izgled posle rotacije

Kao sto vidite rotacija je slicna siftingu sa razlikom sto se istisnuti podaci
vracaju na pocetak registra rotiranu u levu (ROL) ili desnu (ROR) stranu.

Sada smo naucili najveci deo standardnih ASM komandi sa kojima cete se
sretati prilikom reversinga aplikacija, ali ovo ne znaci da smo zavrsili sa
ASMom, naprotiv tek pocinjemo sa zanimljivostima vezanim za ASM
programe.
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ASM FOR CRACKERS - PART |1

Do sada ste naucili kako se koriste osnovne matematicke ASM
komande, sada je vreme da naucite kako da koristite skokove, poredjenja i
slicne programerske stvari iz ASMa.

Zero Flag - je jednobitna memorijska alokacija koja moze drzati samo
dve vrednosti, ili 0 ili 1. Zasto se koristi zero flag? Posto postoje ASM
komande koje porede dve vrednosti, kao rezultat tog poredjenja se postavlja
zero flag usled cega ce se odredjene komande izvrsiti ili ne. Ovo ce vam
sigurno biti jasnije kada dodjete do dela koji objasnjava uslovne skokove.

CMP - je osnovna komanda koja se koristi za poredjenje dve brojevne
vrednosti. Poredjenje se moze vrsiti izmedju dva registra ili izmedju registra i
broja. Ovako oba ova slucaja izgledaju u ASMu:

CMP EAX,EBX
CMP EAX,1

Ovde prvi slucaj poredi EAX sa sadrzajem EBXa. Ako su EAX i EBX jednaki
onda ce zero flag biti postavljen na 1 a ako nisu onda ce zero flag biti jednak
0. CMP je ekvivalent komandi IF iz raznih programskih jezika.

TEST - je napredna komanda koja se koristi za poredjenje dve
brojevne vrednosti. Poredjenje se vrsi na taj nacin sto se poredjeni registri
logicki dodaju jedan na drugi a na osnhovu rezultata koji se ne snima ni u
jedan registar postavlja se zero flag. Ova ASM komanda je oblika:

TEST EAX,EAX

Naravno, kao i kod CMP, komande mogu se porediti ili registri medjusobno ili
registri sa brojevima. U slucaju koji sam dao kao primer, ako je EAX jednak O
onda ce zero flag biti jednak 1, a ako je EAX jednak 1 onda ce zero flag biti
0. Ovo je bitno jer se vecina provera serijskih brojeva zasniva na poredjenju
registra EAX sa samim sobom.

JMP - je jedna od mnogih varijanti iste komande za uslovho /
bezuslovne skokove. Ovi skokovi predstavljaju skakanje kroz kod od jedne
do druge virtualne adrese. Ovakvi skokovi su najcesce pratioci gore opisanih
funkcija za poredjenje registara i brojeva. Primer jedne bezuslovne jump
komande koja se uvek izvrsava je:

JMP 00401000
Posle izvrsenja ove ASM komande program ce izvrsavanje nastaviti od adrese

00401000. Ovaj skok se zove bezuslovni jer nije bitno koja je vrednost zero
flaga da bi se skok izvrsio, to jest skok se bez obzira na bilo koji parametar ili
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registar uvek izvrsava. Postoje razlicite varijacije skokova koje zavise od zero
flaga. JMP komande koje zavise od vrednosti zero flaga (t.j. od njegove
vrednosti zavisi da li ce se skok izvrsiti ili ne) nazivaju se uslovni skokovi. Primeri
ovih uslovnih skokova su JE (skoci ako je zero flag jednak 1) i JNE (skoci ako je
zero flag jednak 0) Spisak svih varijanti ASM skokova:

Hex: Asm: Znaci:

75 ili OF85 JNE/INZ skoci ako nije jednako

74 ili OF84 JE skoci ako je jednako

EB JMP bezuslovni skok

77 ili OF87 JA skoci ako je iznad

0F86 INA skoci ako nije iznad

OF83 JAE skoci ako je iznad ili jednako
OF82 JNAE skoci ako nije iznad ili jednako
OF82 JB skoci ako je ispod

OF83 JNB skoci ako nije ispod

0F86 JBE skoci ako je ispod ili jednako
0F87 JNBE skoci ako nije ispod ili jednako
OF8F JG skoci ako je vece

OF8E ING skoci ako nije vece

OF8D JGE skoci ako je vece ili jednako
OF8C JNGE skoci ako nije vece ili jednako
OF8C JL skoci ako je manje

OF8D JNL skoci ako nije manje

OF8E JLE skoci ako je manje ili jednako
OF8F JNLE skoci ako nije manje ili jednako

Posto smo naucili kako se u ASMu radi takozvano programsko grananje,
iskoristicemo do sada steceno znanje kako bismo resili par jednostavnih
matematickih zadataka. Napisacemo program koji ce izracunati povrsinu
trougla za uneta dva parametra, za unetu stranicu i visinu. Ako je povrsina
trougla manja ili jednaka od 6, onda cemo dodati 3 u izracunatu vrednost za
povrsinu, posle cega cemo u slucaju bilo koje vrednosti povrsine oduzeti
jedan od rezultata. Povrsina trougla se racuna po obrascu: P = (a * h) / 2.

Resenje:
MOV EAX,3
MOV ECX,4
XOR EDX,EDX
IMUL EAX,ECX
MOV ECX,2
DIV ECX
CMP EAX,6
JLE tri
JMP end
tri:
ADD EAX,3
end:
DEC EAX
Za slucaj da vam nije jasno sta se ovde desava objasnicu to u programskom
jeziku C ali i matematicki. Ovako bi to izgledalo u C++:
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#include <iostream>
using namespace std;

int main (int argc, char *argv[])

{
int eax; // Definisi celobrojnu promenljivu
int ecx; // Definisi celobrojnu promenljivu
int edx; // Definisi celobrojnu promenljivu
printf("Unesite bazu trougla: ");
cin >> eax; // Unesi EAX iz konzole
printf("Unesite visinu: ");
cin >> ecx; // Unesi ECX iz konzole
edx = 0; // EDX =0
eax = eax ¥ ecx; // EAX = EAX * ECX
ecx = 2; // ECX =2
eax = eax / ecx; // EAX = EAX / ECX
if(eax <= 6){ // Ako je EAX <=6
eax = eax + 3; // Onda EAX = EAX + 3
b // Kraj uslova ako
eax = eax - 1; // EAX = EAX - 1

printf("Rezultat je: "); // Odstampaj rezultat na ekran
printf("%i",eax);

return 0;
b
Matematicko resenje ovog zadatka bi bilo:
EAX = 3
ECX =4
EDX =0
EAX = EAX * ECX
ECX =2

EAX = EAX / ECX
Ako je EAX <= 6 onda EAX = EAX + 3
EAX = EAX - 1

Kao sto vidite iz ovog C++ source-a ASM JMP komande se pojavljuju na
mestima gde se u C-u ali i u drugim programskim jezicima nalaze IF uslovne
klauzule. Nezamislivi su programi bez poredjenja ili programi bez uslovnih
skokova. Na ovakve mete necete naici prilikom reverserske prakse, stoga je
izuzetno bitno da znate kako se izvrsavaju skokovi...

The Art of Reversing by ApOx Page 20 of 293



ASM FOR CRACKERS - PART 111

Do sada ste naucili kako se koriste osnovne matematicke operacije u
ASMu, kako se radi programsko grananje,... Sada cemo nauciti kako se
koristi STACK.

STACK - predstavlja deo memorije koji se koristi za privremeno
smestanje podataka. Ovi podaci se najcesce koriste za potrebe razlicitih
funkcija koje se nalaze unutar samog PE fajla. O stacku treba razmisljati kao
gomili ploca naslaganih jedna na drugu. Ove ploce su poredjane tako da je
ploca sa brojem 1 sa samom vrhu ove gomile dok se poslednja ploca nalazi
na samom dnu. Ovo znaci da se podaci na stack salju u obrnutom redosledu,
to jest da se prvo prosledjuje poslednji parametar, a tek na kraju se
prosledjuje prvi. Isto kao da slazemo gomilu ploca, slazuci ploce jednu na
drugu, prvo cemo postaviti poslednju plocu, pa cemo polako slagati ploce
jednu na drugu sve dok ne dodjemo do prve ploce. ASM komanda koja se
koristi za slanje podataka na stack je PUSH. Za slucaj da vam ovo nije jasno
dacu kratak primer:

Windowsova Api funkcija GetDIgltemText zahteva sledece parametre:
(1) Handle dialog boxa
(2) Identifikator kontrole iz koje se cita tekst
(3) Adresa u koju se smesta tekst
(4) Maximalna duzina teksta
Stoga ce iscitavanje teksta u ASMu izgledati ovako:

MOV EDI,ESP ; Handle dialog boxa se smesta u EDI
PUSH 00000100 ; PUSH (4) Maximalna duzina teksta
PUSH 00406130 ; PUSH (3) Adresa u koju se smesta tekst
PUSH 00000405 ; PUSH (2) Identifikator kontrole

PUSH EDI ; PUSH (1) Handle dialog boxa

CALL GetDIgltemText ; Pozivanje funkcije koja vraca tekst

Mislim da je svima jasan ovaj primer. Ako vas buni deo koji se odnosi na
handle, njega jednostavno ne posmatrajte, vazno je da razumete da svakoj
funkciji koja ima ulazne parametre prethode PUSH ASM komande koje joj te
parametre prosledjuju u obrnutom redosledu. Kao sto se vidi iz primera
PUSH komanda ima samo jedan parametar i on moze biti ili broj ili registar.

CALL - sigurno ste se pitali sta radi ASM funkcija koju sam pomenuo
na samom kraju dela o STACKu. CALLovi predstavljaju interne podfunkcije
koje predstavljaju zasebnu celinu koda koja je zaduzena za izvrsavanje neke
operacije. Ove funkcije mogu ali i ne moraju imati ulazne parametre na
osnovu kojih ce se racunati neki proracun unutar same funkcije. Ako funkcija
ima ulazne parametre samom CALLu ce prethoditi PUSH komande, a ako
funkcija nema ulazne parametre onda CALLu nece predhoditi ni jedna PUSH
komanda. Da biste shvatili razliku izmedju CALL koji ima ulazne parametre i
onog koji to nema napisacu dve uopstene CALL funkcije:

The Art of Reversing by ApOx Page 21 of 293



+ Slucaj - bez ulaznih parametara:

00403200: CALL 00401001

00403209: DEC EAX

00401001: INC EAX

00401002: ... heke ASM operacije
00401100: RET

Kao sto se vidi u primeru funkciji CALL ne predhode nikakve PUSH
komande iz cega zakljucujemo da CALL na adresi 00403200 nema ulaznih
parametara. Sigurno ste primetili da se na prvoj adresi CALLa, 00401001
nalazi komanda INC EAX. Ova komanda kao i sve ostale komande u CALLu su
proizvoljne i CALL se moze koristiti za bilo sta. Ono sto vas sigurno zanima je
za sta se koristi komanda RET na samom kraju CALLa. Isto kao sto mora
postojati prva komanda u samom CALLu koja zapocinje sekvencu komandi,
tako mora postojati i poslednja komanda u CALLu koja nalaze programu da
se vrati iz CALLa i nastavi sa izvrsavanjem programa. Postoje mnoge
varijacije iste ove komande, kao sto su npr. RET 4, RET 10 i slicne, ali sve
one izvrsavaju jednu te istu operaciju vracanja iz CALLa.

Kako se izvrsavaju napisane komande? Jednostavno, prvo se pozove
doticni CALL, posle cega se izvrse sve komande u njemu zakljucno sa
komandom RET. Posle ovoga se program vraca iz CALLa i sa izvrsavanjem
nastavlja od adrese 00403209, to jest izvrsava se DEC EAX komanda.

+ Slucaj - sa ulaznim parametrima:

00403198: PUSH EAX

00403199: PUSH EBX

00403200: CALL 00401001
00403209: DEC EAX

00401001: PUSH EAX

00401002: PUSH EBX

00401003: ... heke ASM operacije
00401090: POP EBX

00401092: POP EAX

00401100: RET

Kao sto se vidi u ovom primeru CALLu prethode dve PUSH komande
sto znaci da funkcija ima dva ulazna parametra. Ovi ulazni parametri se
nalaze privremeno na STACKu. Primeticete da se parametri funkciji predaju u
obrnutom redosledu, prvo se predaje EAX, a tek onda EBX. Naravnho ovo je
samo tu da ilustruje kako se parametri predaju funkciji, jer u stvarnosti
redosled registara nije bitan, bitan je redosled njihovog slanja na STACK.
Unutar CALLa je sve isto kao i u proslom primeru ali cete na kraju CALLa
primetiti nove POP komande. Sta su to POP komande? POPovi su neophodni
iz razloga sto ako se podaci na pocetku funkcije salju na STACK, na njenom
kraju se svi uneti parametri sa STACKa moraju skinuti pomocu komande
POP. Dakle POP komanda sluzi za skidanje parametara sa STACKa.
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Primecujete da se parametri sa STACKA skidaju u obrnutom redosledu od
njihovog ulaska. Posmatrajte ovo kao odraz registara u ogledalu. I ha samom
kraju posle izvrsenja CALLa, program nastavlja sa daljim izvrsavanjem koda
od prve adrese koja se nalazi ispod poziva CALLu, to jest od 00403209, DEC
EAX komande.

Sada kada smo naucili kako se koriste PUSH,CALL,POP,RET komande, vreme
je da napisemo jedan program. Napisacemo program koji ce pomnoziti dva
broja u jednom CALLu i vratiti rezultat mnozenja.

Resenje:
MOV EAX,3
MOV EBX,4
PUSH ECX
PUSH EAX
CALL mnozenje
RET
mnozenje: PUSH ECX
PUSH EAX
IMUL EAX,EBX
MOV EDX,EAX
POP EAX
POP ECX
MOV EAX,EDX
RET

Mislim da je svima jasno zasto je CALL struktura ovako napisana. Bitno je
samo da zapazite par detalja. Prvo i najvaznije je da se iste PUSH komande
nalazi i ispred CALLa i u samom CALLu. Drugo da se POP komande
primenjuju obrnuto od PUSH komandi. Trece da se rezultat smesta
privremeno u EDX da bi se tek posle POP EAX komande vratio u EAX. Zasto?
Zato sto ce POP EAX komanda vratiti vrednosti 3 u EAX pa ce rezultat
mnozenja biti izgubljen. Stoga se tek posle izvrsenja POP EAX komande EAXu
dodeljuje njegova prava vrednost. Kada se napokon izvrsi CALL, EAX ce
sadrzati vrednost mnozenja, a sledeca komanda koja ce se izvrsiti po izlasku
iz CALLa je druga RET komanda.

Naravno postoji veci broj tipova CALLova ali ovo je uopsteni primer na kome
se moze razumeti sama svrha CALLova i kako se to vracaju vrednosti iz
CALLova.
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ASM FOR CRACKERS - PART IV

Poslednje poglavlje o osnovama ASMa je namenjeno objasnjenju
stringova i pristupanju memoriji iz ASMa.

Stringovi - predstavljaju niz ASCII slova koja zajedno cine jednu
recenicu ili jednu rec. Duzina stringova moze biti proizvoljna ali ono sto je
karakteristicno za stringove je da se svaki string mora zavrsavati sa istim
00h bajtom. Posto ovaj bajt ne predstavlja ni jedno slovo, stringovi se lako
razlikuju od stalog koda. Primera radi evo jednog stringa:

00403040 59 6F 75 72 Your
00403048 20 6E 61 6D 65 20 6D 75 name mu
00403050 73 74 20 62 65 20 61 74 st be at
00403058 20 6C 65 61 73 74 20 66 least f
00403060 69 76 65 20 63 68 61 72 ive char
00403068 61 63 74 65 72 73 20 6C acters |
00403070 6F 6E 67 21 00 ong!.

Kao sto se vidi i svaki karakter stringa ima svoju adresu ali je adresa celog
stringa adresa prvog slova. Kada se cita string koji pocinje od adrese
00403040 on se cita od tog prvog bajta pa sve do poslednjeg 00 bajta.
Zakljucujemo da stringovi predstavljaju sve tekstualne poruke koje se nalaze
u nekom programu.

Memory - Pomocu ASMa je moguce veoma lako pristupiti svim
adresama exe-a koji se trenutno izvrsava. Postoji veci broj komandi i
varijacija istih tako da cu ja navesti samo najcesce koriscene komande.

Postoje dve vrste manipulacije memorijom:

1) Manipulacija samo jednog bajta
2) Manipulacija niza bajtova

BYTE PTR - Prvo cu vam objasniti kako se koristi komanda koja se ponasa
kao referenca ka zadatom bajtu. Za ovo se koristi samo jedna komanda u
obliku:

BYTE PTR DS:[RVA adresa]

U ovoj komandi sve je konstanta osim RVA adrese koja moze biti ili adresa ili
registar. Posto je ovo samo deo komande moze se koristiti sa svim ostalim
komandama koje imaju jedan ili dva parametra. Ovo znaci da se BYTE PTR
moze koristiti uz MOV,XOR,ADD,IMUL,...

DWORD PTR - Za razliku od prosle komande ova komanda se koristi za
pristupanje nizu bajtova. Za ovo se koristi samo jedna komanda u obliku:

DWORD PTR DS:[RVA adresa]

U ovoj komandi sve je konstanta osim RVA adrese koja moze biti ili adresa ili
registar. Posto je ovo samo deo komande moze se koristiti sa svim ostalim
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komandama koje imaju jedan ili dva parametra. Ono sto je jako bitno da
znate da ako koristite komandu DWORD PTR u obliku:

MOV DWORD PTR:[EAX],019EB

Morate da vodite racuna o tome da se bajtovi koji ce se snimiti na lokaciju na
koju pokazuje EAX snimiti u obrnutom redosledu. To jest da biste na lokaciju
EAX snimili recimo EB 19 morate komandu formulisati tako da prvo stavite 0
a tek onda obrnuti redosled bajtova 19 EB. Obratite paznju da se ne okrecu
brojevi iz bajtova nego samo njihov redosled. Naravno ovo nije slucaj kada
se koristi BYTE PTR komanda jer se ona odnosi samo na jedan bajt.
Analiziracemo jedan primer da bismo shvatili kako radi ova manipulacija
memorijom.

00401154  |> /8A10 /MOV DL,BYTE PTR DS:[EAX]
00401156  |. |[2AD1 |SUB DL,CL

00401158  |. |3813 |ADD DL,1

0040115A  |. |75 18 |INZ 00401174

0040115C  |. |40 |INC EAX

0040115D  |. |43 |INC EBX

0040115E  |.~A\E2 F4 \JNE 00401154

Recimo da se u EAXu nalazi neka adresa na kojoj se nalazi string ‘ap0x’,
naravno bez navodnika. Posto se na adresi 00401154 koristi komanda koja
ce u DL registar postaviti samo jedan bajt, vidimo da se radi o jednostavhom
jednobajtnom slucaju. Primeticete takodje da se EAX registar stalno
povecava za jedan, pomocu INC EAX komande. Ovo znaci da ce se za svaki
prolaz ovog loopa u registar DL stavljati jedno po jedno slovo iz naseg stringa
sve dok se sva slova iz stringa ne iskoriste. Kada se ovo desi program ce
nastaviti sa izvrsavanjem koda koji se nalazi ispod adrese 0040115E.

Zasto je bitno razumevanje manipulacije memorijom?

Bitno je iz razloga sto se pomocu direktnog pristupa ASM kodu iz samog exe
fajla delovi koda mogu polymorphno menjati ili se moze proveravati da li je
sam kod na nekoj adresi modifikovan, mogu se napraviti funkcije cije ce
izvrsenje zavisiti od samog sadrzaja koda i tako dalje. Medjutim ako samo
zelite da se bavite reversingom stringovi i manipulacija memorijom su vam
bitni jer se vecina algoritama koji se koriste za proveru serijskih brojeva
zasnivaju na pristupanju delovima ili celom stringu nekog unesenog podatka.
Ovaj podatak moze biti ime, serijski broj... Sto su * PTR komande veoma
bitne za reversere...
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ASM FOR CRACKERS - PART V

Do sada smo se upoznali sa standardnim komandama koje se koriste
za manipulaciju registrima, a sada cemo prosiriti nase vidike i naucicemo sta
su FPU registri i kako se koriste.

Prvo: “Sta su to FPU registri?”. Oni predstavljaju funkciju procesora za
baratanje ciframa sa pokretnim zarezom. Ove cifre su za razliku od 32bitnih
registara (EAX,EBX,...) predstavljene u decimalnom obliku. Izuzetno je bitno
da znate da su 32bitni registri predstavljeni u heksadecimalnom obliku, a da
su FPU registri predstavljeni decimalno. Bez obzira na ovu razliku FPU registri
imaju dosta slicnosti sa 32bitnim registrima.

Prva slicnost je da kao i kod 32bitnih registara i FPU registri imaju
memorijske lokacije koje se mogu ispunjavati brojevima, nad kojima se
kasnije mogu izvrsavati matematicke operacije. Kod 32bitnih registara ove
memorijske lokacije su se zvale EAX,EBX,... a kod FPU registara te lokacije se
zovu STO0,ST1,ST2,..ST7. Njih mozete viditi u istom delu Ollya kao i 32bitne
registre samo ako naslov tog dela prozora bude podesen na Registers (FPU),
a ovo mozete uraditi klikcuci na naziv tog dela prozora. Razlika izmedju ove
dve vrste registara su u velicini broja koji mogu da drze. 32bitni registri
mogu da uzimaju vrednosti od 0000000 - FFFFFFFF, dok FPU registri mogu
imati mnogo vece brojeve kao vrednosti.

Sledeca slicnost izmedju ove dve vrste registara je u tome da se nad
obe vrste registara mogu vrsiti slicne matematicke operacije. Pocecemo od
najjednostavnijih:

BASIC MATH OPERANDS

FPU inicijalizacija - je osnovha FPU komanda koja se koristi kako bi
program saopstio procesoru da sledi niz komandi koje ce pristupati FPU
registrima. Iako se ova komanda, FINIT, koristi i za direktno postavljanje
inicijalnih FPU flagova, ona moze biti izostavljena i FPU registrima se moze
pristupati i bez nje.

Dodeljivanje vrednosti - je osnovna FPU komanda koja se koristi kako
bi se nekim promenljivim (STO0,ST1,...) cija su imena definisana konstanta
dodelila neka vrednost. Ova komanda izgleda ovako:

FLD source - ucitavanje REAL promenljive[primer: 1,22 ili 1,44...]
FILD source - ucitavanje INTEGER promenljive[celobrojna, primer 1,;2]

gde je FLD komanda a source destinacija sa koje se cita niz bajtova koji se
pretvara u real promenljivu i smesta po defaultu u prvi raspolozivi
memorijski prostor, koji je u ovom slucaju STO. Naravno ako se FLD izvrsi jos
jednom ST1 ce dobiti novu vrednost. Primer ovakve komande u praksi bi bio:

FLD TBYTE PTR DS:[403197]
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A znacenje komande je prebaci Tabelu bajtova sa adrese 00403197 u STO
memoriski registar. Tabela bajtova je oblik slican DWORDu ali je veci jer
predstavlja niz bajtova veci od cetiri.

Sabiranje - je osnovna FPU matematicka komanda koja se koristi kako
bi se sabrale dve promenljive. Primera radi mogu se sabrati STO i ST1 tako
da STO drzi rezultat sabiranja. Za ovo se koristi komanda:

FADD destination, source — Dodavanje REAL promenljive
FIADD destination, source — Dodavanje INTEGER promenljive [source]

Primer upotrebe ove komande bi bio:
FADD ST(0), ST(1);
koja u STO registar stavlja rezultat sabiranja registara STO i ST1. Ako se

umesto FADD komande koristi FIADD onda se source parametar prvo
pretvara u ExtendedReal a tek onda sabira sa STO.

Oduzimanje - je osnovna FPU matematicka komanda koja se koristi
kako bi se oduzele dve promenljive. Primera radi moze se od STO oduzeti
ST1 tako da STO drzi rezultat oduzimanja. Za ovo se koristi komanda:

FSUB destination, source — Oduzimanje REAL promenljive
FISUB destination, source — Oduzimanje INTEGER promenljive[source]

Primer upotrebe ove komande bi bio:

FSUB ST(0), ST(1);
koja u STO registar stavlja rezultat oduzimanja STO - ST1. Ako se umesto
FSUB koristi FISUB onda se source parametar pretvara u ExtendedReal tip a
tek onda se oduzima od destination parametra.

Mnozenje - je osnovna FPU matematicka komanda koja se koristi kako
bi se pomnozile dve promenljive. Primera radi STO i ST1 mozemo pomnoziti
tako da rezultat mnozenja sadrzi STO. Za ovo se koriste komande FMUL i
FIMUL.

Primer upotrebe ove komande bi bio:

FMUL ST(0), ST(1);

a njen rezultat bi bio STO = STO * ST1; Ako se umesto FMUL koristi FIMUL

onda se drugi parametar prvo pretvara u ExtendedReal pa tek onda mnozi sa
STO.
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Deljenje - je osnovna FPU matematicka komanda koja se koristi kako
bi se podelile dve promenljive. Primera radi STO i ST1 mozemo podeliti tako
da STO dobije vrednost kolicnika. Za ovo se koriste komande FDIV i FIDIV.

Primer upotrebe ove komande bi bio:
FDIV ST(0), ST(1);

a njen rezultat bi bio STO = STO / ST1; Ako se umesto FDIV koristi FIDIV
onda se drugi parametar prvo pretvara u ExtendedReal pa tek onda deli sa
STO.

Kvadratni koren - je matematicka operacija ciji je rezultat takav broj
koji mnozenjem samog sebe daje broj iz kojeg je vadjen koren. Dakle ako je
5 * 5 = 25, kvadratni koren od 25 je 5. Ova operacija se u ASM poziva samo
sa jednim parametrom koji je ujedno i destination i source. Ova komanda se
zove FSQRT.

Apsolutno - je matetaticka operacija koja preslikava skupove
negativnih vrednosti u njihove pozitivne slike. Ovo znaci da ce posle primene
ove operacije na bilo koji broj vrednost tog broja uvek imati pozitivhu
vrednosti. Dakle ako je broj bio -1,22 posle primenjivanja ove komande na
ovaj broj rezultat ce biti 1,22. Ova komanda se zove FABS i moze se
primenjivati pojedinacno na brojeve i na FPU registre.

Promena znaka - je ekvivalent mnozenja bilo kojeg broja sa vrednoscu
-1. Dakle ako je neki broj ili registar bio negativan, postace pozitivan, i
obrnuto. Ova komanda se zove FCHS i za parametar ima samo jednu
vrednost, ili neki broj ili neki FPU registar.

Sinus/Kosinus - su osnhovne trigonometrijske komande koje u ASMu
izgleda ovako:

FSIN ST(0);
FCOS ST(0);

Dakle ove komande imaju samo jedan parametar koji ujedno predstavlja i
source i destination izvrsenja komande. Dakle sinus/kosinus se racuna na
registru STO (u ovom slucaju) i rezultat komande se takodje smesta u isti
registar. Takodje postoji kombinovana komanda FSINCOS.

MORE OPERANDS

No Operation - je poznata ASM komanda koja se koristi za
popunjavanje praznog prostora i zove se FNOP, a funkcionalni je ekvivalent
ASM komandi NOP koju smo vec upoznali.
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Test - je poznata ASM komanda koja se koristi za logicko poredjenje
vrednosti i najcesce se u ASM koristi u obliku TEST EAX,EAX gde se naravho
umesto EAX moze koristiti bilo koji drugi registar. Kao rezultat ove ASM
komande se dobija postavijanje zero flaga na 1 ako je EAX jednak O i
obrnuto. Kao ekvivalent ove komande za FPU se koristi FTST.

Zamena - je poznata ASM komanda koja se koristi za razmenu
vrednosti izmedju dva registra. Ova komanda ima svoj FPU ekvivalent i on je
FXCH. Ona ce koristi na sledeci nacin:

IF number-of-operands is 1

THEN
temp <- ST(0);
ST(0) <- SRC;
SRC <- temp;
ELSE

temp <- ST(0);
ST(0) <- ST(1);
ST(1) <- temp;

Poredjenje - je poznata ASM komanda koja se koristi za poredjenje
dve vrednosti ili dva registra. Ona ima svoj FPU ekvivalent kada se radi o
poredjenju integer ili real vrednosti. Ako se porede integer vrednosti onda se
koristi FICOM komanda a ako se porede real vrednosti onda se koristi FCOM
vrednost.

FPU registri su vazni za matematicke operacije sa pokretnim zarezom ili za
racunanje vrednosti koje su znato vece od standardnih integer vrednosti.
Mada FPU registri imaju svoje prednosti i svoje primene oni se ne primenjuju
cesto u reverserskoj praksi. Ova kratka tabela najcesce koriscenih FPU
komandi je dodata u knjigu jer je moguce da cete se sresti sa nekim od ovih
komandi prilikom reversovanja nekih crackmea i/ili nekih enkripcija.

NAPOMENA: Ako zelite da razumete sve sto se nalazi u knjizi razumevanje
osnovnih ASM komandi je neophodno za dalje citanje knjige. Ako niste sve
razumeli ili ste nesto propustili predlazem da se vratite i procitate ovaj deo
knjige opet.
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READING TIME TABLE:

Chapter Required Level Minimum reading time

Intro to Cracking newbie 4 days 1 week
NAG Screens newbie 1 day 1 week
Cracking Serials newbie 2 days 1 week
Making KeyGens advanced newbie | 1 week 2 weeks
CD Checking advanced newbie 1 day 5 days
Code Hacking advanced coder 3 days 1 week
“Getting caught” advanced newbie | 3 days 1 week
Cracking it newbie 2 days 1 week
Decrypt me expert coder 1 week 3 weeks
Unpacking advanced newbie 1 week 3 weeks
Patching advanced newbie 1 day 3 days
Nightmare reverser 1 week 4 weeks
Tricks of Trade newbie 1 day 1 day

DOWNLOAD LINKS:

Debugger — OllyDBG v1.10 http://www.Ollydbg.de

Disassembler - W32dasm89 http://www.exetools.com

PE identifikator — PeID 0.93 http://peid.has.it

Hex Editor — Hiew 6.83 http://www.exetools.com

Resource Viewer - Res. Hacker http://rpi.net.au/~ajohnson/resourcehacker
Import rekonstrukter - Import Reconstructer 1.6 http://www.wasm.ru
Process dumper - LordPE 1.4 http://y0da.cjb.net

Ostali alati:

.ap0x Patch Creator RC3 - http://apOx.headcoders.net
Olly2Table 0.1alfa - http://apOx.headcoders.net
HexDecChar 0.4alfa — http://apOx.headcoders.net

the aPE 0.0.6beta — http://ap0x.headcoders.net

Napomena: Ovo su samo neki alati koji ce biti korisceni u knjizi. Njih
smatram osnovnim i pre nego sto pocnete sa daljim citanjem ove knjige
trebalo bi da ih nabavite.
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TOOLS OF TRADE

Kao i za svaku drugu delatnost na kompjuteru za reversni inzenjering
su vam potrebni neki alati (programi) kako biste mogli brze i lakse da dodjete
do informacije koja vam treba. Vecina alata koje cu vam ja ovde preporuciti
mogu se besplatno preuzeti sa interneta i kao freeware proizvodi koristiti i
distribuirati. Pre nego sto pocnem sa listom programa koje cete morati
preuzeti sa interneta prvo cu u par recenica objasniti kakvi su nam to alati
potrebni i za sta oni sluze.

Debugger - Ovo je osnovni alat svakog reversera ali i svakog
programera koji zeli da brzo i lako eliminise greske iz svog koda. Ono sto
nam debugger pruza je mogucnost da nadgledamo izvrsavanje naseg ili
tudjeg koda bas onako kako ga procesor vidi. Da, to znaci da cete morati da
naucite osnove assemblera (masinskog jezika) kako biste mogli da razumete i
kontrolisete izvrsavanje koda. Ovakav tekst sam vec napisao i objavio na
sajtu www.EliteSecurity.org a nalazi se i u ovom izdanju knjige na strani 9
(ovo je dopunjeno izdanje) cije je citanje neophodno radi lakseg snalazenja i
razumevanja tekstova iz ove knjige.

Disassembler - Ovo je dodatni alat za debugger. Naime ako vam
debugger ne da dovoljno informacija o “meti” onda mozete koristiti neke od
disassemblera kako biste lakse wuocili informaciju koja vam treba. Sa
vremenom cete sve manje koristiti ovaj alat posto cete se naviknuti na
asemblerov kod tako da vam ovi alati nece biti potrebni.

PE identifikatori - Ne dajte da vas ovaj naslov zbuni, PE fajlovi su
samo obicni exe fajlovi koji mogu da sadrze neki dodatan kod, koji je
najcesce paker koji sluzi za smanjenje velicine exe fajla. Posto postoji veliki
broj ovakvih pakera i enkriptera pa potrebni su posebni programi za
prepoznavanje istih. Naravno ovo se donekle moze raditi i rucno sto cu vas
takodje nauciti.

Hex Editori - su alati koji nam daju tacan izgled fajla na hard disku i
sluze za fizicko menjanje koda za razliku od menjanja koda u memoriji sto
nam omogucuju debuggeri.

Resource Vieweri - Sluze za pregled, ekstrakciju, izmenu ili
dodavanje exe resursa. Resursi su podaci koji su ukljuceni u sam exe fajl a
mogu biti slike, dijalozi, multimedija, stringovi ili neki drugi tipovi podataka.
Ovi programi u principu nisu neophodni ali nam mogu olaksati posao.

Process dumperi - Sluze prevashodno kod otpakivanja zapakovanih
PE fajlova i omogucavaju nam da celokupnu “sliku” nekog aktivhog programa
snimimo na hard disk.

Import rekonstrukteri - su programi koji sluze za popravljanje
pogresnih ili nedefinisanih poziva ka windows api funkcijama.
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CONFIGURING TOOLS OF TRADE

Vecina gore navedenih alata je vec konfigurisana kako treba i stoga
samo trebamo promeniti izvesne sitnice kako biste jos vise olaksali sebi rad
sa ovim alatima.

OLLYyDBG v.1.10

Podesicemo sledece opcije u OllyDBG programu. Otvorite Olly i idite u
meni za konfiguraciju debuggera [Hint: Options -> Debugging options, ili Alt + O ]
Idemo na Exeptions i tu trebamo iskljuciti sve otkacene opcije. Dalje idemo
na Strings i tamo treba da otkacimo: Decode Pascal strings i Dump non
printable ASCI codes as dots, od mode of string decoding opcija izaberite
Plain opciju. U Disasm opciji kao sintaksu izaberite MASM, a u CPU tabu
selektujte sledece: underline fixups, show directions of jumps, show jump
path, show grayed path if jump is not taken, show jumps to selected
command.

Sledece sto mozemo da podesimo je takozvana kolor sema koja nam
omogucava da lakse uocimo odredjene komande u dissasemblovanom kodu,
kao sto su skokovi i call funkcije. Idemo na Options -> Appearance i tamo u
provom tabu [Hint: General ] treba da iskljucimo restore window position and
appearance. Dalje u defaults mozete izabrati temu koja vam odgovara. Ja
preferiram Black on White kao temu, a Christmas tree kao highlighting
sintakse. Vi mozete izabrati bilo koji ali su po mom misljenju ova dva
najpreglednija. To je sve sto treba da se konfigurise u Olly.

Napomena: OllyDBG je samo jedan od velikog broja debuggera koje mozete
naci na internetu. Izmedju ostalih popularnih mozete jos koristiti i Softlce,
TRW2000 ili neke debuggere koji se koriste specijalno za odredjene vrste
kompajlera (programske jezike kao sto su Visual Basic, Delphi, .Net itd.), ali
samo je Olly besplatan, univerzalan i jednostavno najbolji debugger za
pocetnike ali i za iskusne crackere. Preporucujem da ga koristite jer ce se
dalje u ovoj knjizi on veoma cesto pominjati i koristiti.

w3zZDism++ / W32DAsM 8.93

Podesicemo sledecu opciju u W32Dasmu da bismo osigurali pravilan
prikaz dissasemblovanog fajla. Kliknucemo na Dissasembler -> Font ->
Select font... u listi fontova izabrati Courier New, posle cega cemo izabrati
opciju Save Default Font. I pored ovoga W32Dasm ima dosta bugova:

1) Ako kada otvorite fajl, W32Dasm ne radi premestite fajl u c:\

2) Ako W32Dasm ne nadje dialoge u fajlu koji ih ima skinite novu verziju

3) Ako W32Dasm ne prikaze disasemblovan kod ovo znaci da je fajl pakovan
se nekim pakerom i da se stoga nemoze dissasemblovati (ovo nije bug).
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NUMEGA SMART CHECK V.6.03

Smart Check je specijalni debugger koji se koristi za trazenje gresaka
u programima koji su pisani u Visual Basicu (verzije 5 i 6). Jako je koristan a
u vecini slucajeva je pregledniji i laksi za obradu podataka od Olly-a. Stoga
ako je program koji pokusavate da “razbijete” pisan u Visual Basicu prvo
probajte sa Smart Checkom pa tek onda sa ostalim alatima.

Idemo na Program -> Settings -> Error detection
Otkacite sve checkboxove osim Report Errors immediately.

Idemo na Advanced:
Otkacite samo sledece:
- Report errors caused by other errors
- Report errors even if no source code available
- Report each error only once
- Check all heap blocks on each memory function call
Sve ostalo NE treba da bude chekirano, stisnemo [ OK ] pa idemo dalje...

Idemo na Reporting:
Otkacimo sve osim - Report MouseMove events from OCX, [ OK ], zatvorimo ovaj
meni za konfiguraciju.

Idemo na Program -> Event Reporting

Pritisnite zelenu strelicu u toolbaru da pokrenete selektovani program. Ovo
moze biti bilo koji program pisan u Visual Basicu i onda samo treba da
otkacimo sledece menije:

View -> Arguments ...

View -> Sequence Numbers ...

View -> Suppresed Errors ...

View -> Show errors and specific...
Window -> [2] ... - Program Results

PEID v.0.93

PeID je program koji cemo dosta cesto koristiti kroz ovu knjigu a kao
sto mu ime fajla kaze njegova glavna upotreba je da nam pokaze informacije
o "meti” koju pokusavamo da reversujemo. Ti podaci ukljucuju verziju
kompajlera kao i da li je program pakovan nekim pakerom i kojom verzijom
ako jeste. Ovaj program je po defaultu podesen kako treba ali cemo samo
par stvari podesiti kako bismo sebi olaksali zivot. Pokrenite program i idite na
opcije. Tamo treba da selektujete Hard Core Scan i Register Shell Extensions.
Kliknite na Save i program je uspesno konfigurisan.
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Posto smo konfigurisali alate koji su nam potrebni sada cemo krenuti
sa njihovim koriscenjem. Startujte myCrack.exe koji se nalazi u folderu
...\Casovi\Cas01. Ono sto vidimo je sledeca poruka na ekranu:

slici ovo ce

jednostavan primer
u kome cemo samo
ukloniti  prvi red,
tako da ce program
na ekran izbacivati
samo poruku koja
se trenutno nalazi u
drugom redu.

Kao sto se vidi na
B

Ovaj red cemo da wklonimo t*t%

Press EMTER to continue...

Ovaj zadatak mozda izgleda komplikovano pocetnicima ali uz pomoc prvih
par alata necemo imati nikakvih problema da uspesno i brzo resimo ovaj
problem za cije ce nam uspesno resavanje trebati samo dva alata: W32Dasm
i Hiew. Ali pre nego sto pocnemo sa crackovanjem moram da vam objasnim
same oshove crackovanja.

Crackovanje je tehnika menjanja vec kompajlovanih (gotovih) exe (ali i
drugih tipova) fajlova. Modifikacija fajlova se radi na asemblerskom nivou, sto
znaci da je pozeljho poznavati osnovne principe funkcionisanja asemblerskih
komandi. Naravno ovo i nije obavezno jer mozemo da znamo sta radi neka
asemblerska komanda pomocu logickog razumevanja same komande. Ovo na
najjednostavnijem primeru znaci da logikom mozemo doci do zakljucka sta
radi ova komanda: MOV EAX,1... Naravno pogadjate da je ova komanda
ekvivalentna matematickoj funckiji EAX = 1. Osnovha komanda koja ce nham
trebati za ovaj prvi cas je NOP. Ona je osnovna crackerska komanda i znaci
da se na redu u kome se ona nalazi ne desava bas nista. To znaci da ce
program proci preko nje i nece uraditi bas nista. Zasto nam je ovo bitno???
Prilikom crackovanja postoje komande koje zelimo da izmenimo ili da
obrisemo. Posto u crackovanju nije pozeljno brisati deo fajla jer bi tako nesto
ispod reda koji brisemo moglo da se poremeti, zato koristimo ovu NOP
komandu da izbrisemo mesta koja nam ne trebaju. Naravno ova mesta nece
biti fizicki izbrisana nego program jednostavno nece raditi nista na mestu na
kojem se nalazila komanda koju smo obrisali i nastavice dalje. Prikazano

asemblerski to izgleda ovako. Ako imamo sledece asemblerske komande:

MOV EAX,1
INC EAX
ADD EAX,5

mozemo da pretpostavimo sta se ovde desava. Matematicki to izgleda ovako:
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EAX =1
EAX = EAX + 1
EAX = EAX + 5

Mislim da je svima jasno koji je rezultat EAXa posle izvrsavanja ove tri
komande. Recimo da nam taj rezultat ne odgovara i da bismo hteli da EAX na
kraju izvrsavanja ove tri komande bude manji za jedan nego sto je sada.
Jednostavno cemo spreciti da se EAXu doda 1 u drugom redu i resicemo

problem. Sada bi to izgledalo ovako:
MOV EAX,1

NOP

ADD EAX,5

Vidmo da smo jednostavno NOPovali drugi red i da se on sada ne izvrsava
kao INC EAX nego kao NOP, zbog cega se rezultat EAXa ne menja posle
izvrsavanja tog reda.

Prvo otvorimo ovu “metu” u W32Dasmu i u njemu potrazimo tekst koji
zelimo da uklonimo. Kada se program ucita u W32Dasm onda preko Find
opcije potrazimo tekst poruke koju trebamo da uklonimo. Idemo na Search ->
Find -> Ovaj red -> OK. Videcemo ovo:

* Beferenced by a CALL at Address:

| :0040116E

|

:00401ZBa EE push ebp

:00401ZEE =239EL wow ebp, esp

:004012EB S3ECOS sub esp, 00000002

:004012C0 S3E4F0 and esp, FFFFFFFO

:004012C3 BEOOOOOOOO mow eax, 00000000

:00401ZC8 =294L5FC wow dword ptr [ebp-04], eax
:00401ZCE SEB4L5FC wmow eax, dword ptr [ebp-04]
:004012CE ESEDES0000 call 00403CCO

00401203 E=2CE2130000 call 00402540

100401208 S3ECOS sub esp, 00000002

:004012DE SEREET74200 push 00422708

:004012E0 S3ECOC sub esp, 0000000C

* Possible Stringhata Pef from Code Obj ->"Owaj red cemo da uklonimo !II"

:004012E2 220124000 push 00401220
:004012E2 &2E0534300 push 00435350
:004012ED ESFALIDOZ00 call 004230EC
t00401:2F2 S3C414 add esp, 00000014
t00401EZFE EO push eax
:004012Fs ES2LERO0100 call 00413020
t004012FE 23C410 add esp, 00000010

Kao sto vidimo prvi red ispod nadjenog teksta je zaduzen za prikazivanje
poruke na ekran. Ono sto zakljucujemo je da ako samo NOPujemo taj red
onda cemo ukloniti poruku sa ekrana. POGRESNO !!! Ovde se namece jedan
problem, ako NOPujemo samo taj red onda cemo dobiti gresku u programu i
program ce se srusiti jer ga nismo pravilno modifikovali. Problem lezi u
cinjenici da je za prikazivanje teksta na ekranu zaduzeno vise redova.
Shvatite ovo kao funkciju koja ima vise parametara. Na primer:
prikazi_tekst_na_ekran(parametarl, parametar2, parametar3,...)
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ova funkcija za prikazivanje teksta na ekranu ima tri parametra koja su joj
potrebna da prikazu tekst na ekranu. Ono sto smo mi hteli da uradimo je da
joj oduzmemo jedan parametar zbog cega bi se program srusio. Problem lezi
u tome sto svaka funkcija mora imati dovoljan broj parametara, ovaj broj ne
sme biti ni veci ni manji od potrebnog za tu funkciju. Ono sto je zgodno kod
asemblera je da mi ne moramo znati koliko parametara kojoj funkciji treba.
Primeticete par PUSH komandi koje prethode jednoj CALL komandi. Ove
komande predstavljaju ono sto sam objasnjavao na primeru iznad, pri cemu
PUSH komande predstaviljaju parametre funkcije a sam CALL predstavlja
funkciju. Ono sto je takodje bitho da zapamtite je da se u asembleru
parametri funkcijama prosledjuju u obrnutom redosledu. Prvo se prosledjuje
poslednji parametar, a pre samog pozivanja funkcije prosledjuje se i prvi
parametar. Ovo znaci da ne smemo samo da NOPujemo CALL, ili samo da
NOPujemo PUSH funkcije, mi da bismo sklonili ispisivanje poruke sa ekrana
moramo da NOPujemo sve PUSHeve i na kraju sam CALL. Primecujete da se
tri reda ispod poruke koju zelimo da uklonimo sa ekrana nalazi CALL koji
sluzi za prikazivanje poruke na ekran. Pre njega se nalaze ne dva nego tri
PUSHa, dva ispod teksta poruke i jedan iznad. Ne dajte da vas zbuni to sto
se izmedju PUSH komandi nalaze neke druge ASM komande, one nas ne
interesuju, interesuju nas samo PUSHevi i CALL. Pre nego sto pocnemo sa
samim crackovanjem detaljnije cu objasniti prozor koji trenutno vidite u
W32Dasmu. Ono sto vidimo je ovo:

* Beferenced by a CALL at Address:

| :0040116E

|

00401 ZBAL|EE push ebp

00401 ZEE||22ES wow ebp, esp
O0401EZBI||[223ECOE sub esp, 00000002
O040LECOY|22E4FO and esp, FFFFFFFO
O0401zC3|EBE00000000 mow eax, 00000000
oo401zZCc8||2245FC wmow dword ptr [ebp-04], eax
00401 ZCE||2E45FC wmow eax, dword ptr [ebp-04]
O0401ECE|ESEDEZ 20000 call 00403CC0

0040103 [EECE1 30000 call 00402840

O0401Z08 |223ECOS sub esp, 00000008

O0401EDE EED 2274200 push 00422708
O040LEEQ|223ECOC sub esp, 0000000C

* Possible Stringlata Pef from Code Obj -="Owaj red cemo da uklonimo !IIM

:004012E2 &2201E4000 push 00401220
:004012E8 &2E0534300 push 00435350
:004012ED ESFALIDOZ00 call 004Z30EC
:004012Fz S3C414 add esp, 00000014
t00401EFE EO push eax
:004012F& ES2EZA0100 call 00413020
:004012FE 23C410 add esp, 00000010

Crveno uokvireni deo koda oznacava virualne adrese na kojima se nalazi ta
linija koda. Posmarajte ove brojeve kao da su brojevi 1,2,3 i da predstavljaju
red izvrsavanja programa. U ovom primeru prva adresa od koje krece
izvrsavanje tzv. OEP (original entry point) je 0040100, a sve ostale adrese se
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povecavaju za odredjeni broj. Ovaj broj ne mora biti uvek jedan, veoma
cesto i nije jedan. Taj broj direktno zavisi od sadrzaja koji se nalazi uokviren
plavo na slici. Ovi hex brojevi predstavljaju komande koje su u fajlu zapisane
u HEX obliku. Tako je HEXa decimalno 55 ekvivalentno ASM komandi PUSH
EBP. Primeticete da se ovi HEX brojevi pisu iskljucivo u paru po dva. Samo
dvocifreni HEX brojevi predstavljaju komande koje su ekvivalentne onima
koje su na slici uokvirene zelenom bojom. Nama je za ovaj primer bitno da
se ASM komanda NOP u HEX obliku pise kao 90. Ovo znaci da je jedno 90
ekvivalentno jednoj komandi NOP. Da bismo NOPovali jedan red moramo da
zamenimo sve dvocifrene HEX brojeve iz tog reda sa 90. Na primer ako
brisemo red koji se nalazi na adresi 004012E0 moracemo da zamenimo
sadrzaj ove adrese (83ECOC) sa tri NOP komande (909090) jer postoje tri
para dvocifrenih brojeva u toj liniji. Primetite kako se to adrese povecavaju,
videcete da se recimo iza adrese 004012C0 nalazi 004012C3. Logicno je za
ocekivati da se iza 004012C0 nalazi 004012C1, ali ovde se nalazi 004012C3.
Ovo se desava zato sto se u ASMu svakom dvocifrenom broju dodeljuje samo
jedna adresa. Dakle ako je adresa 004012C0O onda se na toj adresi nalazi
samo jedan dvocifreni broj i to 83, na adresi 004012C1 se nalazi E4, a na
adresi 004012C2 FO. Jedini razlog zasto su ove tri adrese spojene u jedan
red je zato sto te tri adrese predstavljaju samo jednu ASM komandu, pa zbog
toga je prva sledeca adresa, na kojoj se nalazi sledeca ASM komanda,
004012C3. Adrese redova odgovaraju adresi prvog dvocifrenog hex broja
(bajta) koji se nalazi u toj “liniji” koda.

Posto smo naucili kako da patchujemo (modifikujemo) program
predjimo na samu modifikaciju. Program mozete editovati u Hiewu ali i u bilo
kom drugom hex editoru. Posto je Hiew najbolji za pocetnike sva objasnjenja
u prvom poglavlju bice vezana za njega. Dakle startujete Hiew u otvorite
myCrack.exe pomocu njega. Prvobitan prikaz u Hiewu nam je nerazumljiv pa
cemo ovaj prikaz pretvoriti u prikaz koji je istovetan prikazu iz W32Dasma.
Ovo radimo pritiskom na F4 i selekcijom Decode moda. Sada vec vidimo ASM
komande. Ako niste zapamtili pogledajte gornju sliku ponovo i prepisite
adrese koje treba da NOPujemo, te adrese su: 004012DB, 004012E3 i
004012E8 i 004012ED. Ako zelimo da odemo na te adrese u Hiewu treba da
pritisnemo dugme F5 i ukucamo prvo tacku pa adresu na koju zelimo da
odemo. Kada odemo na prvu adresu videcemo istu onu PUSH komandu iz
W32Dasma. Posto smo naucili da treba da NOPujemo sve dvocifrene brojeve
iz tog reda, zapamticemo dva zadnja bajta. Dakle zadnja dva bajta koja
cemo NOPovati su 42 i 00. Sada pritisnite F3 da udjete u Edit mod i kucajte
nove bajtove kojima zelite da zamenite stare, ti bajtovi su 90. Moracemo da
unesemo 5x 90 da bismo NOPovali ceo red. Postavite kursor na sledecu
adresu koju treba da NOPujete, to jest na sledecu PUSH komandu i sa njom
uradite isto. Isti postupak ponovite i sa zadnjom PUSH komandom i sa
CALLom. Kada zavrsite rezultat bi trebalo da izgleda kao na sledecoj slici:
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Dakle sve adrese sa PUSH i CALL komandama su NOPovane. Da bismo snimili
promene pritisnimo F9, a za izlazak iz programa pritisnite F10. Probajte
slobodno da startujete program koji ste malopre patchovali i videcete da on
nece raditi!!! Iako smo sve dobro uradili, patchovali smo sve PUSH i CALL
komandu program pravi gresku. Ono sto nismo ocekivali, a trebalo je, da je
ovo DOS program i da posle ispisivanja poruke na ekran program prebacuje
kursor u novi red. Ovo se desava odmah ispod ispisivanja poruke koju smo
uklonili, sto znaci da sledeci CALL sluzi bas za ovo. Otvorimo ponovo HIEW i
ukucajmo adresu 004012F2. Odmah ispod ove adrese videcemo jednu PUSH
komandu i jedan CALL.
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Ocigledno je da i ovu CALL i PUSH komandu treba NOPovati jer program ne
moze da prebaci kursor u sledeci red bez ispisivanja poruke na ekran. Znaci
NOPovacemo i adrese 004012F5 i 004012F6, snimicemo fajl i pokusacemo
ponovo da startujemo program. Videcemo da smo sada uspeli i da se poruka
vise ne pojavljuje. Uspeli smo da crackujemo nas prvi program.
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MY SECOND CRACK

Posto smo konfigurisali alate koji su nam potrebni sada cemo krenuti
sa njihovim koriscenjem. Startujte myFirstCrack.exe koji se nalazi u folderu
..\Casovi\Cas01. Ono sto cete videti je obican Dos prozor koji kaze da nije
crackovan. Ovo cemo da promenimo. Otvorimo ovaj program u W32Dasmu
[Hint: Disassembler -> Open File to disassemble ], sacekajmo koji trenutak da bi
se pojavio disassemblovani program. Posto je ovo drugi cas necu mnogo
analizirati nego cemo uraditi samo ono sto je potrebno da bismo crackovali
ovaj program. Podsetimo se one poruke koju nam je program izbacio, sada
bismo trebali da saznamo odakle se ona poziva. Ovo mozemo uraditi na dva
nacina. Prvi je preko find opcije u programu, a drugi, nama malo korisniji, je
preko opcije String Reference u W32dasmu. Znaci pritisnimo predzadnje
dugme u toolbaru na kojem pise Str Ref i novi prozor ce se otvoriti. U tom
prozoru cemo pronaci poruku koju je program izbacio (Nisam crackovan :P) i
kliknucemo 2x na nju, sto ce nas odvesti do tacnog mesta u kodu ovog exe
fajla odakle se ova poruka poziva. Program ce nas odvesti ovde:

* Referenced by a (U)nconditional or (C)onditional Jump at Address:
[:0040128C(C)

:004012EF 837DFC00 cmp dword ptr [ebp-04], 00000000
:004012F3 754C jne 00401341

:004012F5 83ECO08 sub esp, 00000008

:004012F8 6848284200 push 00422848

:004012FD 83ECOC sub esp, 0000000C

* Possible StringData Ref from Code Obj ->"Nisam crackovan :P"

:00401300 6880124000 push 00401280 <- Ovde smo
:00401305 6850534300 push 00435350
:0040130A E84D1E0200 call 0042315C

* Referenced by a (U)nconditional or (C)onditional Jump at Address:
|:004012A8(C)

:0040130F 83C414 add esp, 00000014
:00401312 50 push eax
:00401313 ES8D82A0100 call 00413DF0
:00401318 83C410 add esp, 00000010
:0040131B 83EC08 sub esp, 00000008
:0040131E 6848284200 push 00422848
:00401323 83ECOC sub esp, 0000000C

Vidimo poruku “Nisam crackovan :P”. Znaci odavde se poziva ova poruka.
Ono sto je predmet ovog casa je da vas naucim kako da se umesto ove
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poruke pojavi neka druga poruka koja se vec nalazi u istom exe fajlu. Ako
pogledamo malo iznad ove poruke videcemo jedan uslovni skok:

:004012F3 754C jne 00401341

Ovo znaci ako nesto nije jednako program ce skociti na 00401341. Ako
odemo malo dole da vidimo sta se nalazi na toj adresi videcemo sledece:

* Referenced by a (U)nconditional or (C)onditional Jump at Address:
|:004012F3(C)
|

:00401341 837DFC01 cmp dword ptr [ebp-04], 00000001

100401345 754C jne 00401393 <-Vazan skok koji kad se izvrsi
:00401347 83ECO08 sub esp, 00000008 ; poruka se preskace.
:0040134A 6848284200 push 00422848

:0040134F 83ECOC sub esp, 0000000C

* Possible StringData Ref from Code Obj ->"Uspesno si me crackovao :)"

|
:00401352 68AE124000 push 004012AE

Primeticemo da se tu nalazi poruka “Uspesno si me crackovao :)” koja
ce se prikazati na ekranu samo ako se skok sa adrese 004012F3 uvek
izvrsava. Ono sto moramo da primetimo je da se izmedju adrese 00401341 i
adrese 00401352 nalazi jos jedan skok koji treba da izmenimo. Da bismo
uspesno crackovali ovaj program treba da izmenimo onaj skok na adresi
004012F3 sa INE (75 hex) u JMP (EB hex) da bi se uvek izvrsavao to jest da
bi progam uvek stizao do adrese 00401341, a skok na adresi 00401345 da
promenimo tako da se nikad ne izvrsava, to jest da ga promenimo u dva
NOPa (No Operation). Kada ovo zavrsimo uvek ce se na ekranu prikazivati
poruka o uspesnom crackovanju. Ako vam ovaj deo nije jasan obratite
paznju na hex adrese na koje vode skokovi. Videcete da nas oni vode ispod i
preko poruka koje zelimo da se prikazu na ekranu. Mi moramo da izmenimo
ove skokove tako da se uvek na ekranu prikazuje poruka koju mi zelimo. Ovo
je mozda najbitniji deo knjige, sama osnova. Da biste uspesno napredovali
dalje morate da shvatite kako menjanje odredjenih komandi utice na
ponasanje programa. Stoga predlazem da ako se prvi put srecete sa
crackovanjem uradite ovu prvu oblast temeljno i da ne prelazite na druge
oblasti bez prethodnog razumevanja ove i bez samostalnog resavanja prve
vezbe koja se nalazi na kraju ovog poglavlja. Radjenje vezbi je preporucljivo
jer ce vam pomoci da se osamostalite i da sami resavate probleme, koje
niste pre toga videli i obradili.

Da bismo izvrsili ove promene u programu treba da ga iskopiramo u
direktorijum gde se nalazi Hiew i otvorimo ga pomocu njega.
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Posto nam ovaj prvobitan prikaz nije bas razumljiv, pritiskom na F4 2x
prelazimo u Decode oblik koji je isti kao onaj koji smo videli u W32Dasmu.
Mozemo da skrolujemo dole do adrese 004012F3 koju hocemo da izmenimo
a mozemo i da idemo do te adrese sa komandom GoTo. Pritisnite F5 i prvo
unesite tacku, pa adresu 004012F3 i onda enter. Sada kada smo na toj
adresi, mozemo je menjati prelaskom u edit mode sa F3. Stavite kursor na
prvi bajt 75 i kucajte EB. Evo kako to treba da izgleda:
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Sa F9 snimamo promene. Sada treba da promenimo i drugi skok. Pritisnite
F5 i unesite tacku, pa adresu 00401345 i onda pritisnite enter. Sada kada
smo na toj adresi, mozemo je menjati prelaskom u edit mode sa F3. Stavite
kursor na prvi bajt 75 i kucajte 9090. Evo kako to treba da izgleda:

83ECHS
684828420908 : §3ECHS

: 83ECHC : 6848284280
68AE124800 83ECHAC
6850534380 68AEL 24080
ESFB1DB280 6858534380
83C414 ESFBiD@AZ280

5@ 83C414
E8862nA100 5@

83C418 E8862A0100

83ECBS8 83C410

6848284200 83ECH8

83ECAC 6848284200
6893124800 83ECHC

6858534300 6893124000
ESD51D0200 6858534300

830414 E§D51D020@

59 83C414

ES6A2AA100 5@

83C41@ ES602A0100

83ECAC 83C41@ Novo
6380524300 83ECHC )

Sa F9 snimamo promene a sa F10 izlazimo iz Hiew-a. Sada mozete startovati
ovaj exe fajl i videcete da ce on uvek prikazivati istu poruku, “Uspesno si me
crackovao :)”
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Mozete pogledati fajl ..\Casovi\Casl\main.cpp da vidite kako taj program
izgleda u programskom jeziku C++. Kao sto vidite:

#include <iostream>
using namespace std;

int main (int argc, char *argv[])
{
inti;
i =0;
if (i ==0){
cout << "Nisam crackovan :P" << endl;
cout << "Press ENTER to continue..." << endl;

b

if (i==1){

cout << "Uspesno si me crackovao :)" << endl;
cout << "Press ENTER to continue..." << endl;

b
cin.get();
return O;

b

postoje dva uslova. Ako je I jednako nula onda se pokazuje poruka da
program nije crackovan, a ako je I jednako jedan onda se prikazuje poruka
da je program crackovan. Posto je I uvek jednako nula ono sto smo mi
uradili je kao da smo zamenili uslove, to jest kao da je za prvu poruku
potrebno da je I jednako jedan a za drugu da je I jednako nula. Ovo je malo
komplikovaniji primer jer je potrebno izmeniti dva skoka ali kada savladate
ovo moci cete da crackujete veliki broj programa za pocetnike jer se skoro
svi zasnivaju na ovom ili slicnom principu.

Vezba:

Ako zelite mozete proveriti do sada steceno znanje na istom primeru ili
na slicnom vec pripremljenom fajlu. ...\Casovi\Cas1\myFirstTest.exe je fajl koji
treba da crackujete sami. Sam postupak se ne razlikuje mnogo od
prethodnog primera. U ovom testu treba ispraviti samo jedan skok. Za one
koji znaju ili pomalo razumeju C++ tu je i ..\Casovi\Cas1\test.cpp da pogledaju
razlike izmedju prvog primera [ ovog testa, a fajl
...\Casovi\Cas1\myFirstTest.cracked.exe je primer kako treba da izgleda konacan
crackovan program. Radjenje vezbi kroz ovu knjigu je preporucljivo kako
biste lakse zapamtili postupke crackovanja na slicnim primerima.

Resenje:

Treba promeniti skok na adresi 00401391 sa JNE (755E) u JMP (EB5E).
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OLLYDBG FROM BEGINNING

Pre nego sto pochnemo sa ozbiljnijim reverserskim problemima
naucicete kako rade debuggeri i sto je najvaznije kako se koristi Olly.

Kao sto je vec receno na pocetku knjige debuggeri su alati koji su
dizajnirani tako da nam omoguce nadgledanje izvrsenja svake ASM
instrukcije bilo kojeg programa. Ovde se jasno vidi prednost koju debugeri
imaju nad disassemblerima koji nam omogucuju jednostavan pregled
“mrtvog koda”. Naravno mrtav kod je samo zargonski naziv za staticni ASM
kod ciji detaljan pregled mozemo videti ali ne mozemo da vidimo kako se kod
ponasa prilikom njegovog izvrsavanja, to jest ne mozemo znati kad se i zasto
izvrsavaju skokovi, koje parametre uzimaju CALLovi... Iz ovog razloga je za
posmatranje rutina najbolje koriscenje debuggera kao sto je Olly.

DEBUGGING BASICS - BREAKPOINTS

Vec je receno da debuggeri imaju moc da zaustave sve posmatrane
programe i da njihove instrukcije izvrsavaju redom, jednu po jednu. Ali kako
se u stvari pauzira program?

Da bi se ovo desilo, odnosno da bi debuggovani program zastao bas na
jednoj specificnoj adresi, potrebno je da jedan od sledeca dva uslova bude
ispunjen: 1) Da je postavljen obican software breakpoint na toj adresi ili 2)
Da je postavljen hardware breakpoint na toj adresi. Ali sta je to u stvari
break-point?

Logicno bi bilo da razmisljate o break-pointu kao komandi koju mi
zadajemo nasem debuggeru kako bi on zastao na zeljenoj adresi. Ali
software break point nije samo interna komanda u nasem debuggeru, on je u
stvari fizicko menjanje sadrzaja memorije na takav nacin da nas debugger
moze da detektuje ovakvu promenu i zastane bas kada se ona desi. Naravno
posle ovakvog pauziranja programa originalni sadrzaj memorije biva
povracen zbog cega smo mi nesvesni modifikacije memorije iako se ona u
stvari desava. Posto je svakoj virutualnoj adresi, odnosno komandi, u jednom
programu dodeljena tacno jedna adresa moguce je postaviti breakpoint na
svaki pojedinacni bajt u memoriji. Ali ovde se namece jedan problem. Naime
posto svaki bajt u fajlu moze imati samo vrednosti u opsegu 00h - FFh,
odnosno od 0 do 255, kakav to bajt biva zapisan u memoriju tako da nas
debugger prepozna break-point. Odgovor na ovo pitanje lezi u arhitekturi
procesora koji je dizajniran tako da svaki bajt, sam po sebi ili u skupini
bajtova, cini jednu celinu odnosno komandu. Tako ce procesor bajtu 90
dodeliti komandu NOP, bajtu C3 komandu RET itd. Upravo jedan od ovih
bajtova ima takvu namenu da hardware-ski pauzira izvrsenje programa i da
kontrolu nad procesom preda inicijatoru-vlasniku procesa. Ovaj bajt je
oznacen sa CCh i ima asemblersku interpretaciju kao INT3 komanda. Kada
ona bude izvrsena debug exception handler biva pozvan i sva kontrola nad
daljim izvrsenjem programa biva prepustena debuggeru. Naravno sve ovo se
odnosi samo na software-break pointove koje postavljamo pomocu naseg
debuggera.
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Nasuprot njima postoje i takozvani hardware break-pointi koji su
posebna moguchost svakog procesora. Oni se za razliku od softwareskih
breakpoint izvrsavaju na direktnom hardwareskom nivou procesora
omogucavajuci tako pauziranje bilo kojeg programa direktno, bez ikakve
modifikacije memorije aktivnog fajla. Ovo je moguce iz razloga sto se svaki
proces izvrsava na nacin na koji procesor tacno zna adresu komande koja se
trenutno izvrsava i zato moze, po potrebi, da zaustavi na svakoj komandi.
Posto nema modifikacije memorije ovakvi break-pointi ne mogu biti
detektovani kao modifikacija memorije nekog programa.

DEBUGGING BASICS - USER VS KERNEL MODE

Tacniji naziv ovog poglavlja bi bio ring3 vs ring0. Sta je to u stvari
user odnosno kernel mode debugging?

Sam Windows®™ je dizajniran na takav nacin da nemaju svi programi
pristup svim delovima raspolozive memorije. Postoje dva nivoa pristupa koja
programi mogu da imaju, ring3 i ring0. Glavni, odnosno kernelski, nivo
pristupa se naziva ring0 i njemu mogu da pristupe samo sistemski programi
koji direktno cine operativni sistem. Svi ostali programi imaju samo
ogranicen pristup komponentama sistema cineci tako user mode, ili drugacije
ring3. Da biste lakse zamislili kakav pristup imaju razliciti fajlovi razmisljajte
na sledeci nacin: Program Internet Explorer direktno ima samo ring3 pristup
dok se pomocu sistemskih .dll fajlova povezuje sa ring0. Ovi sistemski fajlovi
su recimo kernel32.dll i user32.dll koji imaju pristup nativhim windows API
pozivima koji su dalje direktno povezani sa procesorskim funkcijama.

Ovakva podela pristupa sistemskoj memoriji je uslovila podelu
debuggera na user i kernel mode debuggere. Iako su kernel mode debuggeri
mocniji iz razloga sto oni imaju pristup svim delovima sistema u svakom
trenutku mi cemo se kroz ovu knjigu zadovoljiti radom sa user mode
debuggerima iz razloga sto cemo reversovati aplikacije koje nemaju direktan
pristup sistemu.

Da bismo uocili razliku, odnosti prednosti jednog moda u odnosu na
drugi razmotrimo slucaj kada moramo da postavimo breakpoint na API koji
se koristi za citanje teksta iz nekog prozora. Problem kod postaviljanja
ovakvog break-pointa je u tome sto vise API funkcija moze da cita podatke iz
prozora tako da je potrebno ili izolovati tacan API koji se koristi za citanje
podataka iz prozora ili postaviti breakpoint na sve APIje. U ovakvim
slucajevima kernel mode debuggeri imaju prednost nad user mode
debugerima jer oni mogu da postave breakpoint na low-level kod koji se
koristi za citanje podatka iz prozora omogucavajuci nam tako da lociramo
tacan API koji pristupa nekom prozoru i cita tekst.

INTRODUCTION TO OLLYDBG

Za reversere OllyDBG, koji je napisao Oleh Yuschuk, predstavlja
osnhovni i nezaobilazni alat. Iako se moze desiti da je za neki specificni
reverserski problem potrebno koriscenje kernel mode debuggera, Olly skoro
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uvek predstavlja pravi izbor kada pristupamo nekom problemu. Ovo znaci da
iako je Olly ogranicen na ring3 pristup i dalje predstavlja vise nego dovoljno
reversersko sredstvo. Ali sta to cini Olly tako dobrim?

Prevashodno Ollyjeva snaga lezi u njegovom izuzetno mocnom
disassembleru pomocu kojeg je analiza ASM koda podignuta na najvisi
moguci nivo. Ovo znaci da Olly moze da prepozna loopove, switcheve, moze
da nam pokaze lokacije na koje vode skokovi, zna sve parametre koje uzima
bilo koja standardna Windows®™ API funkcija. Sta vise moze se reci da je
Olly jedan od najboljih, ako ne i najbolji debugger ikada napravljen. Iz ovog
razloga ce se autor ove knjige prilikom debugginga aplikacija prvenstveno
koncentrisati na njegovu upotrebu.

OLLYDBG 's KEY FEATURES

Ono sto cete prvo videti kada otvorite neki program u Ollyu je sledece
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Ovaj prozor je glavni Olly prozor koji je nazivan CPU prozor iz razloga sto
prikazuje ASM komande koje procesor izvrsava i sto je pomocu njega
moguce nadgledanje i izvrsavanje komandu po komandu.
Kao sto se vidi na slici iznad ovaj prozor je podeljen na pet celina koje
zajedno cine jednu izuzetno funkcionalnu celinu. Na slici su ove celine vec
obelezene i sada cemo preci jednu po jednu celinu.

CPU prozor je glavni prozor u Ollyu i njegova n